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Project Accounting Sample Reports
This document includes information about and instructions for creating 
the most common Project Accounting reports. Samples of each report also 
are included.

The following reports are explained:

• Aged Work-In-Progress Report
• Fees List by Project Report
• Pre-Billing Worksheet - CP/FP
• Pre-Billing Worksheet – Fee (Billable)
• Pre-Billing Worksheet – T&M and Fee (Billable)
• Pre-Billing Worksheet – CP/FP and Fee (Billable)
• Billing List
• Timesheet History Report
• Projects In Progress - Customer List
• Projects in Progress - Fees List
• Projects in Progress - Cost Category/Transaction List
• Year To Date Employee Utilization List
• Project Cost Breakdown List
• Project Cost Breakdown – Periodic List
• Change Order
• PA Detailed Trial Balance

The following section lists the Report Writer name of each report:

• Project Accounting Report Writer Name Reference



2 P R O J E C T A C C O U N T I N G S A M P L E R E P O R T S

Aged Work-In-Progress Report

The Aged Work-In-Progress Budget report displays information about 
work in progress across aging periods you have set up and the balances 
or unbilled work in progress per budget. Use this report to analyze billing 
activity by budget for time and materials projects.

To print an Aged Work-In-Progress Report list:
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Aged Work-In-Progress Budget from the Reports list and 
choose New to open the Billing Activity Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

6. Choose Print.

Report Writer name
PA Aged Work-In-Progress 

Budget

Report tables
PA Budget MSTR WIP SUM

PA Project Master File

RM Customer MSTR

PA Cost Category Master File

Ranges
Customer Name

Customer ID

Sorting options
Budget Name

Budget ID
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Aged Work-In-Progress Report

  System: 6/5/2012  1:51:32 PM                                                                         User Date:   6/5/2012
  Page: 1                                                                                              User ID:     sa
   
                                                        Fabrikam, Inc.        
                                                         Project Series
   
                                                      Aged Work in Progress
                                                 For Time and Materials Projects
   
   
   Ranges:
      Customer ID:    ADVANCED0001 - ADVANCED0001
      Customer Name:  First - Last
   
   Sorting:  by Project Number
   
   
   Project Number    Project Name
  -------------------------------------------------------------------------------------------------------------------------------
   Cost Category ID  Cost Category Name                   Current    31 - 60 Days    61 - 90 Days     91 and Over          Total
  -------------------------------------------------------------------------------------------------------------------------------
   
   ADSTVCOMM         TV Commercials
   
   BUILDING          Building                               $0.00           $0.00           $0.00           $0.00           $0.00
   CASH              Cash                                   $0.00           $0.00           $0.00           $0.00           $0.00
   CLOTHING          Clothing                               $0.00           $0.00           $0.00         $480.00         $480.00
   CONSULTING        Consulting Fees                        $0.00           $0.00           $0.00       $1,068.75       $1,068.75
   DESIGN            Product Design                         $0.00           $0.00           $0.00           $0.00           $0.00
   HARDWARE          Hardware Purchase                      $0.00           $0.00           $0.00           $0.00           $0.00
   INSURANCE         Insurance                              $0.00           $0.00           $0.00           $0.00           $0.00
   TELCOMM           Telephone Communication                $0.00           $0.00           $0.00           $0.00           $0.00
   XHARDWARE         Testing Non -IV Item                   $0.00           $0.00           $0.00           $0.00           $0.00
   YHARDWARE         Testing Non-IV Item - MU               $0.00           $0.00           $0.00           $0.00           $0.00
   ZHARDWARE         Testing Non-IV Item - None             $0.00           $0.00           $0.00           $0.00           $0.00
                                                   --------------  --------------  --------------  --------------  --------------
                                                            $0.00           $0.00           $0.00       $1,548.75       $1,548.75
   
   
   FIRST             First
   
   CONSULTING        Consulting Fees                        $0.00           $0.00           $0.00       $7,500.00       $7,500.00
   DESIGN            Product Design                         $0.00           $0.00           $0.00     $300,000.00     $300,000.00
   INSURANCE         Insurance                              $0.00           $0.00           $0.00           $0.00           $0.00
   MANAGEMENT        Project Management                     $0.00           $0.00           $0.00           $0.00           $0.00
   TELCOMM           Telephone Communication                $0.00           $0.00           $0.00           $0.00           $0.00
   TRACKER           Tracker Module                         $0.00           $0.00           $0.00           $0.00           $0.00
                                                   --------------  --------------  --------------  --------------  --------------
                                                            $0.00           $0.00           $0.00     $307,500.00     $307,500.00
   
   
   SECOND            Second
   
   CASH              Cash                                   $0.00           $0.00           $0.00           $0.00           $0.00
   CONSULTING        Consulting Fees                        $0.00           $0.00           $0.00       $7,500.00       $7,500.00
   COPIER            Copier Charges                         $0.00           $0.00           $0.00           $0.00           $0.00
   DEMO              Sales Demonstration                    $0.00           $0.00           $0.00           $0.00           $0.00
   DESIGN            Product Design                         $0.00           $0.00           $0.00      $15,000.00      $15,000.00
   DESIGNREVIEWS     Design Reviews                         $0.00           $0.00           $0.00           $0.00           $0.00
   EBILL             Ebill                                  $0.00           $0.00           $0.00           $0.00           $0.00
   LAND              Land                                   $0.00           $0.00           $0.00           $0.00           $0.00
   MANAGEMENT        Project Management                     $0.00           $0.00           $0.00           $0.00           $0.00
   SUPPLIES          Supplies                               $0.00           $0.00           $0.00           $0.00           $0.00
   TELCOMM           Telephone Communication                $0.00           $0.00           $0.00           $0.00           $0.00
   XHARDWARE         Testing Non -IV Item                   $0.00           $0.00           $0.00     $439,750.00     $439,750.00
   YHARDWARE         Testing Non-IV Item - MU               $0.00           $0.00           $0.00     $432,500.00     $432,500.00
   ZHARDWARE         Testing Non-IV Item - None             $0.00           $0.00           $0.00     $391,250.00     $391,250.00
                                                   --------------  --------------  --------------  --------------  --------------
                                                            $0.00           $0.00           $0.00   $1,286,000.00   $1,286,000.00
   
                                                   ==============  ==============  ==============  ==============  ==============
                                                            $0.00           $0.00           $0.00   $1,595,048.75   $1,595,048.75
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Fees List by Project Report

The Fees List by Project report displays a list of all the fees being used in 
all projects per customer. In addition to project information, the report 
shows the fee ID, fee name, fee type and the fee amount, percentage of 
baseline cost or percentage of baseline revenue.

To print a fee list-project:
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Aged Work-In-Progress from the Reports list and choose 
New to open the Billing Activity Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

6. Choose Print.

Report Writer name
PA Fees List - by Project

Report table
PA Project Master File

RM Customer MSTR

PA Contract Master File

Pa Project Fee Master File

PA Fee Master File

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting options
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department
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Fee List - Project

 System: 9/22/07   1:02:43 AM                                                                User Date:   9/22/07
 Page: 1                                                                                     User ID:     SA
                                                       Fabrikam, Inc.
                                                       Project Series
                                                   Fees List by Project
 Range:
   Customer ID:          First - Last
   Contract Number:      First - Last
   Project ID:           First - Last
   Project Number:       First - Last
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
 Sorting: by Customer ID
 -----------------------------------------------------------------------------------------------------------------------
  Project No.     Project Name                   Project Class ID  Project ID   Contract Number   Customer ID
 -----------------------------------------------------------------------------------------------------------------------
    Project Manager ID  Business Manager ID  Department
 -----------------------------------------------------------------------------------------------------------------------
            Fee ID          Fee Name             Fee Type         Fee Amount  % of Baseline Cost  % of Baseline Revenue
 -----------------------------------------------------------------------------------------------------------------------
  AFITZCONST      Construction of Net Housing                      CONST        FITZNTHAUS        AARONFIT0001
    BARR0001                                    ENG
            AFITZRETAIN     AFITZ Retainage      Retentions        $58,136.75             0.00%                0.00%
 
 AFREQ           A. Fitz Requirements Analysis                    REQUIREMENTS  AFITZAUTO         AARONFIT0001
    BARR0001                                    ENG
            CONTR_MGT       Contract Mgmt        Retainer          $20,000.00             0.00%                0.00%
     2 Projects
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Pre-Billing Worksheet - CP/FP

The Pre-Billing Worksheet - CP/FP list displays a list of pre-billing 
worksheets for all cost plus or fixed-price projects.

You can print two types of pre-billing worksheets.

In process Includes billable transactions that are in the billing entry 
work file.

Billable Includes all billable transactions that are in the transaction 
history files.

Print this report to verify billing activity, tax amounts, total amounts and 
earnings for each project. This report also shows fee information, such as 
the fee ID, type, amount due, tax amount, and billable fee amount.

To print a pre-billing worksheet - CP/FP:
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Pre-Billing Worksheet - CP/FP from the Reports list and 
choose New to open the Billing Activity Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

6. Choose Print.

Report Writer name
PA Pre-Billing Worksheet - CP/

FP

Report table
PA Pre Billing Worksheet 

TEMP

PA Billing Sub-Detail WORK 
TM

PA Billing Sub-Detail TM 
Temp2

PA Billing Sub-Detail WORK 
FF

PA Billing Sub-Detail WORK 
FF Temp

PA Billing Sub-Detail WORK 
Fee

PA Billing Sub-Detail WORK 
Fee Temp

PA Billing Subline Tax Detail

PA Billing Subline Tax Detail 
Temp

PA Billing Header WORK

RM Customer Master

PA Billing Detail WORK

PA Project Master File

PA Billing Notes Master

PA Contract Master FIle

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting options
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Include
In Process

Billable

Cutoff Date
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Pre-Billing Worksheet - CP/FP

  System: 2/26/2007  1:21:42 PM                                                                               User Date: 2/26/2007
  Page: 1                                                                                                     User ID:   sa
                                                            Fabrikam, Inc.
                                                             Project Series
   
                                                Pre-Billing Worksheet - CP/FP (Billable)
   
  Range:
    Customer ID:                First - Last
    Contract Number:            First - Last
    Project ID:                 First - Last
    Project Number:             ADSBILL - ADSBILL
    Project Class ID:           First - Last
    Project Manager ID:         First - Last
    Business Manager ID:        First - Last
    Department:                 First - Last
    Contract Class ID:          First - Last
    Customer Billing Cycle ID:  First - Last
    Contract Billing Cycle ID:  First - Last
    Project Billing Cycle ID:   First - Last
   
  Sorting:  by Customer ID
   
  Cutoff Date:  2/26/2013
   
   
  Project Number  Type               Project Name                   Project PO Number
 -------------------------------------------------------------------------------------------------------------------------------------
    Cost Category ID  % Comp         Amount Earned    Previously Billed   Earned This Period     Retention Amount       Billing Amount
 -------------------------------------------------------------------------------------------------------------------------------------
   
  ADSBILL         Cost Plus          Billboard Ads
   
    Timesheet
   
    DESIGN               0.00%                $0.00                $0.00                $0.00                $0.00                $0.00
                                                                                               -------------------  -------------------
                                                                 Transaction Usage Totals:                   $0.00                $0.00
   
    Equipment Log
   
    FEEREVENUE           0.00%                $0.00                $0.00                $0.00                $0.00                $0.00
                                                                                               -------------------  -------------------
                                                                 Transaction Usage Totals:                   $0.00                $0.00
   
    Miscellaneous Log
   
    COPIER               1.17%            $6,787.76                $0.00            $6,787.76                $0.00            $6,787.76
                                                                                               -------------------  -------------------
                                                                 Transaction Usage Totals:                   $0.00            $6,787.76
   
    Purchasing Invoice
   
    OFFICE SUPPLIES      0.48%            $2,419.37                $0.00            $2,419.37                $0.00            $2,419.37
    XHARDWARE            1.12%                $0.00                $0.00                $0.00                $0.00                $0.00
                                                                                               -------------------  -------------------
                                                                 Transaction Usage Totals:                   $0.00            $2,419.37
   
    Employee Expense
   
    CABFARE              0.00%                $0.00                $0.00                $0.00                $0.00                $0.00
                                                                                               -------------------  -------------------
                                                                 Transaction Usage Totals:                   $0.00                $0.00
   
                                                                                               -------------------  -------------------
                                                                           Project Totals:                   $0.00            $9,207.13
   
  System: 2/26/2007  1:21:42 PM                                                                               User Date: 2/26/2007
  Page: 2                                                                                                     User ID:   sa
   
                                                            Fabrikam, Inc.
                                                             Project Series
   
                                                Pre-Billing Worksheet - CP/FP (Billable)
   
   
  Project Number  Type               Project Name                   Project PO Number
 -------------------------------------------------------------------------------------------------------------------------------------
    Cost Category ID  % Comp         Amount Earned    Previously Billed   Earned This Period       Billing Amount     Retention Amount
 -------------------------------------------------------------------------------------------------------------------------------------
                                                                                               ===================  ===================
                                                                            Report Totals:                   $0.00            $9,207.13
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Pre-Billing Worksheet – Fee (Billable)

The Pre-Billing Worksheet – Fee (Billable) displays the billable amount for 
fees for a particular project. 

To print a Pre-Billing Worksheet – Fee (Billable):
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Pre-Billing Worksheet - T&M or Pre-Billing Worksheet - CP/
FP from the Reports list and choose New to open the Billing Activity 
Report Options window.

3. Enter an option name and select the range and sorting method.

4. Mark the Billable option to include billable fee amounts. Do not mark 
the Single Billable Report option.

5. Choose the Destination button to open the Report Destination 
window.

6. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

7. Choose Print.

Report Writer Name
PA PBW Fee

Tables
PA Reports Project TEMP

PA Project Master File

PA Billing Sub-Detail WORK 
Fee Temp

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department 



P R O J E C T A C C O U N T I N G S A M P L E R E P O R T S 9

Pre-Billing Worksheet – Fee (Billable)

System: 2/26/2013  1:22:47 PM                                                                                                                   
User Date: 2/26/2013
Page: 1                                                                                                                                         
User ID:   sa
                                                                                    Fabrikam, Inc.
                                                                                    Project Series
   
                                                                        Pre-Billing Worksheet - Fee (Billable)
   
  Range:
    Customer ID:                First - Last
    Contract Number:            First - Last
    Project ID:                 First - Last
    Project Number:             ADSBILL - ADSBILL
    Project Class ID:           First - Last
    Project Manager ID:         First - Last
    Business Manager ID:        First - Last
    Department:                 First - Last
    Contract Class ID:          First - Last
    Customer Billing Cycle ID:  First - Last
    Contract Billing Cycle ID:  First - Last
    Project Billing Cycle ID:   First - Last
   
  Sorting:  by Customer ID
   
  Cutoff Date:  2/26/2013
   
   
  Project Number  Type               Project Name                   Project PO Number
 -------------------------------------------------------------------------------------------------------------------------------------
     Fee ID          Fee Name          Fee Type              Amount Due    Previously Billed         Trade Amount     Retention Amount       
Billing Amount
 -------------------------------------------------------------------------------------------------------------------------------------
   
    ADSBILL         Cost Plus         Billboard Ads
   
    PROF FEE                          Retainer                $2,000.00         $600.00         $0.00         $0.00           $1,400.00
    SALES INCOME                      Project Fee            $10,000.00       $4,000.00         $0.00         $600.00         $6,000.00
                                                             ----------       ----------      ---------     ----------      ----------
                                      Project Totals:                                           $0.00         $600.00         $7,400.00
   
                                                                                           =============   =============   =============
                                      Report Totals:                                            $0.00         $600.00         $7,400.00
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Pre-Billing Worksheet – T&M and Fee (Billable)

The Pre-Billing Worksheet - T&M and Fee list displays a list of pre-billing 
worksheets for all time and material projects and the fees attached. You 
can print pre-billing worksheets that contain all billable transactions that 
are in the transaction history files. You can print the billable amount for 
the specified cutoff date.

To print a pre-billing worksheet - T&M and Fee 
(billable):
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Pre-Billing Worksheet - T&M from the Reports list and 
choose New to open the Billing Activity Report Options window.

3. Enter an option name and select the range and sorting method.

4. Mark the Billable option to include billable fee amounts.

5. Mark the Print Single Billable Report option to print a single report 
that contains both transactions and fees.

6. Choose the Destination button to open the Report Destination 
window.

7. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

8. Choose Print.

Report Writer Name
PA PBW - T&M and Fee

Tables
PA Pre Billing Worksheet 

TEMP

PA Billing Sub-Detail TM 
Temp2

PA Billing Sub-Detail WORK 
FF Temp

PA Billing Sub-Detail WORK 
Fee Temp

PA Billing Notes Master

PA Billing Detail TEMP

PA Project Master File

PA Contract Master File

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department 
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Pre-Billing Worksheet – T&M and Fee (Billable)

  System: 2/26/2008  1:11:56 PM                                                                                                                                      
User Date:  2/26/2008
  Page: 1                                                                                                                                                            
User ID:    sa
   
                                                                                         Fabrikam, Inc.
                                                                                         Project Series
   
                                                                              Pre-Billing Worksheet - T&M (Billable)
   
   
   
  Ranges:
    Customer ID:                First - Last
    Contract Number:            First - Last
    Project ID:                 First - Last
    Project Number:             ADSTVCOMM - ADSTVCOMM
    Project Class ID:           First - Last
    Project Manager ID:         First - Last
    Business Manager ID:        First - Last
    Department:                 First - Last
    Contract Class ID:          First - Last
    Customer Billing Cycle ID:  First - Last
    Contract Billing Cycle ID:  First - Last
    Project Cycle ID:           First - Last
   
  Sorting:  by Customer ID
   
  Cutoff Date:  2/26/2008
   
   
   
 Project Number  Type                 Project Name            Project PO Number           Billings           Fees      Trade Discount
 -------------------------------------------------------------------------------------------------------------------------------------
 ADSTVCOMM      Time and Materials    TV Commercials                                      $1,098.75         $30.00      $56.44
   
  
T&M Billings: 
 
Date       Cost Owner      Cost Owner Name          Cost Category ID  Billing Rate  Markup%   Total Cost   Qty    Trade Amount   Amount
 -------------------------------------------------------------------------------------------------------------------------------------
 1/9/2008  COMPUTER0001    Computer Training Systems  CONSULTING      $75.00        0.00%     $165.53      8.25   $30.93         $618.75
  Client Consulting
 1/9/2008  GARDNERS0001    Gardner Services           DESIGN          $0.00         0.00%     $106.26      6.00    $0.00           $0.00
   Research design and specification of new products and projects
 1/27/2008  ADVER           Advertising Expense       INSURANCE       $0.00         0.00%     $9,032.46   11.28    $0.00           $0.00
 1/20/2008  FINANCE         Finance Charge Expenses   TELCOMM         $0.00         0.00%     $2,015.00   20.00    $0.00           $0.00
 1/20/2008  GKCLEANI0001    G & K Cleaning            CLOTHING        $120.00       0.00%     $2,000.00    4.00   $24.00         $480.00
                                                                                              ---------  ------   -------        -------
                                                                                              $13,319.25  49.53   $54.93       $1,098.75
   
   
   
  Fees:
   
   Fee ID          Type                Amount Due        Prev. Billed        Trade Amount    Retention Amount      Billing Amount
 ----------------------------------------------------------------------------------------------------------------------------------
   LEGAL FEES      Service                 $30.00               $0.00               $1.50               $0.00              $30.00
                                                                        ------------------  ------------------  ------------------
                                                                                    $1.50               $0.00              $30.00
   
   
  
 
 
 
 
   
                                                                                                                                                          
Total Billings:          $1,098.75
                                                                                                                                                              
Total Fees:                $30.00
                                                                                                                                                    
Total Trade Discount:      $56.44
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Pre-Billing Worksheet – CP/FP and Fee (Billable)

The Pre-Billing Worksheet - CP/FP and Fee list displays a list of pre-
billing worksheets for all cost plus or fixed-price projects and the fees 
attached. You can print pre-billing worksheets that contain all billable 
transactions that are in the transaction history files. You can print the 
billable amount for the specified cutoff date.

To print a pre-billing worksheet - CP/FP:
1. Open the Billing Activity Reports window.

(Reports >> Project >> Billing Activity)

2. Choose Pre-Billing Worksheet - CP/FP from the Reports list and 
choose New to open the Billing Activity Report Options window.

3. Enter an option name and select the range and sorting method.

4. Mark the Billable option to include billable fee amounts.

5. Mark the Print Single Billable Report option to print a single report 
that contains both transactions and fees.

6. Choose the Destination button to open the Report Destination 
window.

7. In the Report Destination window, select a printing destination and 
choose OK to return to the Billing Activity Report Options window.

8. Choose Print.

Report Writer Name
PA PBW - CP/FP and Fee

Tables
PA Pre Billing Worksheet 

TEMP

PA Billing Sub-Detail TM 
Temp2

PA Billing Sub-Detail WORK 
FF Temp

PA Billing Sub-Detail WORK 
Fee Temp

PA Billing Notes Master

PA Billing Detail TEMP

PA Project Master File

PA Contract Master File

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department 
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Pre-Billing Worksheet – CP/FP and Fee (Billable)

  System: 2/26/2013  1:23:10 PM                                                                                                                                      
User Date:  2/26/2013
  Page: 1                                                                                                                                                            
User ID:    sa
   
                                                                                         Fabrikam, Inc.
                                                                                         Project Series
   
                                                                             Pre-Billing Worksheet - CP/FP (Billable)
   
   
   
  Ranges:
    Customer ID:                First - Last
    Contract Number:            First - Last
    Project ID:                 First - Last
    Project Number:             ADSBILL - ADSBILL
    Project Class ID:           First - Last
    Project Manager ID:         First - Last
    Business Manager ID:        First - Last
    Department:                 First - Last
    Contract Class ID:          First - Last
    Customer Billing Cycle ID:  First - Last
    Contract Billing Cycle ID:  First - Last
    Project Billing Cycle ID:   First - Last
   
   Sorting:  by Customer ID
   
   Cutoff Date:  2/26/2013
   
   
   
  Project Number                      Project Name                                               Billings                Fees      Trade 
Discount
 -------------------------------------------------------------------------------------------------------------------------------------
---------------------------------------------------------
  ADSBILL         Cost Plus           Billboard Ads                                              $9,207.13           $7,400.00             
$830.36
   
   
  CP/FP Billings:
   
   Cost Category ID  % Comp       Amount Earned   Previously Billed  Earned This Period    Retention Amount      Billing Amount
 --------------------------------------------------------------------------------------------------------------------------------
   CABFARE             0.00%               $0.00               $0.00               $0.00               $0.00               $0.00
   COPIER              1.17%           $6,787.76               $0.00           $6,787.76               $0.00           $6,787.76
   DESIGN              0.00%               $0.00               $0.00               $0.00               $0.00               $0.00
   FEEREVENUE          0.00%               $0.00               $0.00               $0.00               $0.00               $0.00
   OFFICE SUPPLIES     0.48%           $2,419.37               $0.00           $2,419.37               $0.00           $2,419.37
   XHARDWARE           1.12%               $0.00               $0.00               $0.00               $0.00               $0.00
                                                                                          ------------------  ------------------
                                                                                                       $0.00           $9,207.13
   
   
   
  Fees:
   
   Fee ID          Type                Amount Due        Prev. Billed        Trade Amount    Retention Amount      Billing Amount
 ----------------------------------------------------------------------------------------------------------------------------------
   PROF FEE        Retainer              $2,000.00             $600.00               $0.00               $0.00           $1,400.00
   SALES INCOME    Project Fee          $10,000.00           $4,000.00               $0.00             $600.00           $6,000.00
                                                                        ------------------  ------------------  ------------------
                                                                                     $0.00             $600.00           $7,400.00
   
   
 
 
 
 
 
 
 
 
 
   
                                                                                                                                                             
Total Billings:             $9,207.13
                                                                                                                                                                 
Total Fees:             $7,400.00
                                                                                                                                                       
Total Trade Discount:               $830.36
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Billing List

Billing List displays information for each transaction entered in the 
billing entry window and posted. The report shows billing information 
like cost owner, cost category ID, quantity, amount, rate, markup 
percentage, writeup or writedown amount or percentage and account 
distributions.

To print a billing list:
1. Open the Posting Journal Reports window.

(Reports >> Project >> Posting Journal)

2. Choose Billing from the Reports list and choose New to open the 
Posting Journal Report Options window.

You can display information on posted revenue recognition and project 
closing by selecting Revenue Recognition and Project Closing Lists from the 
dropdown list.

3. Enter an option name and select other options you want to include in 
your report.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Posting Journal Report Options window.

6. Choose Print.

Report Writer name
PA Billing Posting Journal 

OPEN Reprint

Report table
PA Pre Billing Worksheet 

TEMP

PA Billing Sub-Detail OPEN 
TM

PA Billing Sub-Detail TM 
Temp2

PA Billing Sub-Detail OPEN FF

PA Billing Sub-Detail WORK 
FF Temp

PA Billing Sub-Detail OPEN 
Fee

PA Billing Sub-Detail WORK 
Fee Temp

PA Billing Subline Tax Detail 

PA Billing Subline Tax Detail 
Temp 

PA Billing Header OPEN

RM Customer MSTR

Posting Definitions Master

PA Billing Detail OPEN

PA Project Master File

PA Billing Notes Master

Ranges
Audit Trail Code

Batch ID

Post Date

Sorting options
Audit Trail Code

Batch ID

Post Date

Include
Posting Journal

History

Open
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Billing List

 System:  10/23/2010 6:47:02 PM                                                                                                                                                               
User Date:  10/23/2010
 Page:  1                                                                                                                                                                                     
User ID:    sa
                                                                                                            Fabrikam, Inc.        
                                                                                                            Project Series
                                                                                              Billing Entry Posting Journal Open Reprint
 Ranges:
   Audit Trail Code: PABL00000001 - PABL00000001
   Batch ID:         First - Last
   Post Date:        First - Last
 Sorting: by Audit Trail Code
______________________________________________________________________________________________________________________________________
 Document No.:        TM001
 Document Date:       01/10/2008
 Customer ID:         ADVANCED0001
 Customer Name:       Advanced Paper Co.
 Customer PO Number:
 Comment:
 Cutoff Date:         01/10/2008
 Batch ID:
 Post Date:           01/10/19
 Audit Trail Code:    PABL00000001
______________________________________________________________________________________________________________________________________
 Project Number:      ADSTVCOMM                      Billings:                           $450.00
 Project Name:        TV Commercials                 Fees:                                 $0.00
 Project PO Number:                                  Trade Discount:                      $22.50
 T&M Billings:
                                                                                Current                                                                          
Invoice
--------------------------------------------------------------------------------------------------------------------------------------
                                                                                                                                Writeup/        
Writeup/
  Date     Cost Owner     Cost Cat ID     Tax Amount  Billing Rate    Markup %       Qty           Amount      Type     Writedown          
---------- -------------  --------------  ----------  --------------  -----------    ----------    ----------  -------- ---------
 01/08/19   BARR0001      CONSULTING      $29.93      $75.00          0.00%          6.00          $450.00     STD      $0.00 
         

  Amount    Writedown %    Billing Rate    Markup %    Qty             Amount
---------- -------------  --------------  ----------  -------------- -----------
 $0.00      0.00%          $75.00          0.00%       6.00           $450.00

Client Consulting                                     -------------- -----------
                                                       6.00           $450.00
 Fees:
  Fee ID          Type         Amount Due      Prev. Billed    Billing Amount   Tax Amount
 --------------- ------------ --------------- ---------------- ---------------- ----------------
  LEGAL FEES      Service               $0.00            $0.00            $0.00            $0.00
                                                               ---------------- ----------------
                                                                          $0.00            $0.00
______________________________________________________________________________________________________________________________________
 Project Number:      FIRST                          Billings:                         $5,000.25
 Project Name:        First                          Fees:                                 $0.00
 Project PO Number:                                  Trade Discount:                     $250.01
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Timesheet History Report

Print the Timesheet History Report to display posting activity of 
timesheet transactions. Timesheets track the labor cost and amount of 
time expended on a project. A timesheet transaction can involve various 
projects, cost categories, pay codes, pay rates, positions, and dates.

To print timesheet history reports:
1. Open the History Reports window.

(Reports >> Project >> History)

2. Choose Timesheet from the Reports list and choose New to open the 
History Report Options window.

To display information on other posted transactions by selecting Employee 
Expenses, Equipment Log, Miscellaneous Logs, Inventory Transfer, 
Purchase Order, Receivings, and Purchasing Invoice from the drop-down 
list.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the History Report Options window.

6. Choose Print.

Report Writer name
PA History Timesheet

Report table
PA Timesheet Detail History 

File

PA Timesheet Header History 
File

Ranges
Employee ID

Project Number

Cost Category ID

Batch ID

Document Date

Document Number

Date Incurred

Transaction Type

Sorting options
Employee ID

Project Number

Cost Category ID

Batch ID

Document Date

Document Number

Date Incurred

Include
Billable

In Process

Closed

Non Billable

Fixed Fee Transactions
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Timesheet History Report

 System: 9/22/07    1:11:19 PM                                                                                                                 
User Date:   9/22/07
 Page: 1                                                                                                                         User ID:     SA
                                                                        Fabrikam, Inc.        
                                                                        Project Series
                                                                    Timesheet History Report
  Ranges:
     Employee ID:       First - Last
     Project Number:    First - Last
     Cost Category ID:  First - Last
     Batch ID:          First - Last
     Document Date:     First - Last
     Document No.:      First - Last
     Date Incurred:     First - Last
     TRX Type:          First - Last
 Exclude:  Billable: No    In Process: No    Closed: No    Non-Billable: No    Fixed Fee Trx:  No
 Sorting: by Employee ID

 Doc Date  Doc No.         Batch ID   Employee ID    Date   Project No.  Cost Category ID  Time Begin  Time End  Qty   Billing Status
--------------------------------------------------------------------------------------------------------------------------------------
      U of M    Unit Cost  Pay Code  Department  Position  Total Cost   Billed Qty   Billed Amt   Approved Quantity    Approved Bill Amt
--------------------------------------------------------------------------------------------------------------------------------------
9/21/00  TS000000000000001 DYNSA     DIAZ0001       9/16/05  HOTELEDGER   CONSULTING        12:00 AM   12:00 AM  10.00  Closed
      Hour      $43.27     SALY      ENG         MGR1      $432.70       10.00        $1,600.00   0.00                  $0.00
 
9/21/00  TS000000000000002 DYNSA     DIAZ0001       9/16/05  HOTELEDGER   CONSULTING        12:00 AM   12:00 AM   1.00  Billable
      Hour      $43.27     SALY      ENG         MGR1      $43.27        0.00         $0.00       0.00                  $0.00
   
9/21/00  TS000000000000003 DYNSA     DIAZ0001       9/16/05  HOTELEDGER   DESIGN            12:00 AM   12:00 AM   3.00  Billable
      Hour       $17.10    SALY      ENG         MGR1      $228.81       0.00         $0.00       0.00                  $0.00

 Report Totals:                                                                                                                                                                       

 Total Cost                                                                                                                                                                
 -------------
 $704.78
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Projects In Progress - Customer List

The Projects In Progress - Customer list displays the estimated revenues 
and profits, revenues earned, total cost incurred, cost of revenues, gross 
profit or loss, amount billed to date, recognized revenues, and estimate 
cost to complete to each project.

To print a Project In Progress - Customer list:
1. Open the Performance Reports window.

(Reports >> Project >> Performance)

2. Choose Projs. in Progress-Customer from the Reports list and choose 
New to open the Performance Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Performance Report Options window.

6. Choose Print.

Report Writer name
PA Projects in Progress 

Master File

Report table
PA Project Periodic Totals 

TEMP

PA Project Periodic Totals 
TEMP2

PA Project Periodic Totals 
TEMP3

RM Customer Master

PA Contract Master File

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Sorting options
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Include
Year

Period
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Project in Progress - Customer List

System:2/26/2007  12:58:30 PM                                                                                                                                                                   
User Date: 2/26/2007
Page:  1                                                                                                                                                                                        
User ID: sa
                                                                                                     Fabrikam, Inc.
                                                                                                     Project Series
                                                                                            Projects in Progress - Customer
                                                                                                    As of 1/31/2007
Ranges:
   Customer ID:          First - Last
   Contract Number:      ADS - ADS
   Project ID:           First - Last
   Project Number:       First - Last
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
Exclude:  Posted: No     Unposted: No
Sorting:  by Customer ID
 Customer Number       Customer Name
--------------------------------------------------------------------------------------------------------------------------------------
 Project Number   Project Name                   Estimated Revenues  Estimated Profits
--------------------------------------------------------------------------------------------------------------------------------------
 From Inception to 1/31/2007                        |         At 1/31/2011        |                For the year ended 12/31/2007
--------------------------------------------------------------------------------------------------------------------------------------
Revenues Recognized  Total Cost   Committed   Cost of Gross Profit   Billed to Estimate Cost  |  Cost & Est.  Billings in   | Revenues     
Recognized        Cost of Gross Profit
         
Earned Revenue        Incurred Costs      Revenues (Loss)            Date to Complete  |  Earnings in Excess of |        Earned Revenue       
Revenues (Loss)  |    Excess of Costs & Est. |  |     Billings       Earnings |
--------------------------------------------------------------------------------------------------------------------------------------
 ADVANCED0001          Advanced Paper Co.
 ADSBILL          Billboard Ads                        $2,025,693.09         $73,126.09
           $0.00           $0.00     $34,699.52     $44,199.13          $0.00          $0.00      $10,000.00   $1,917,867.48           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 ADSNEWS          Newspaper Ad                         $3,072,152.24      ($438,247.76)
       $3,022.04       $3,022.04     $29,310.00          $0.00      $2,760.00        $262.04           $0.00   $3,481,090.00           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 ADSPRODUCTION    Production                             $115,650.00          $9,637.50
           $0.00           $0.00     $18,541.53          $0.00          $0.00          $0.00       $2,650.00      $87,470.97           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 ADSRADIO         Radio Commercials                    $2,083,433.01        $381,310.24
           $0.00           $0.00  $7,367,336.43          $0.00          $0.00          $0.00       $6,200.00 ($5,665,213.66)           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 ADSTALENTS       Artists                              $5,620,412.50        $380,037.50
           $0.00           $0.00     $10,498.00          $0.00          $0.00          $0.00           $0.00   $5,229,877.00           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 ADSTVCOMM        TV Commercials                       $4,309,601.55         $15,521.45
         $450.00           $0.00  $3,927,639.15     $18,697.97      $1,181.93      ($731.93)         $480.00     $366,440.95           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
--------  --------  -------  -------  -------  -------  --------  --------  -------  -------  -------  -------  -------- --------
       $3,472.04       $3,022.04 $11,388,024.63     $62,897.10      $3,941.93      ($469.89)      $19,330.00   $5,417,532.74           
$0.00          $0.00           $0.00          $0.00          $0.00          $0.00
                                                                                                                                                       
ADVANCED0001    Total Estimated Revenues:          $17,226,942.39
                                                                                                                                                        
ADVANCED0001    Total Estimated Profits:              $421,385.02
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Projects in Progress - Fees List

The Projects In Progress - Fees list displays the estimated revenues and 
profits, revenues earned, total cost incurred, cost of revenues, gross profit 
or loss, amount billed to date and estimate cost to complete to each 
project.

To print a Project In Progress - Fees list:
1. Open the Performance Reports window.

(Reports >> Project >> Performance)

2. Choose Projs. in Progress-Customer from the Reports list and choose 
New to open the Performance Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Performance Report Options window.

6. Choose Print.

Report Writer name
PA Projects in Progress 

Master File

Report table
PA Project Periodic Totals 

TEMP

PA Project Periodic Totals 
TEMP2

PA Project Periodic Totals 
TEMP3

RM Customer Master

PA Contract Master File

Ranges
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Sorting options
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Include
Year

Period
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Projects in Progress - Fees List

System: 2/26/2006  1:00:44 PM                                                                                                                            
User Date: 2/26/2006
Page:   1                                                                                                                                                
User ID:   sa
                                                                                   Fabrikam, Inc.
                                                                                   Project Series
                                                                             Projects in Progress - Fees
                                                                                    As of 1/31/2007
 Ranges:
   Customer ID:          First - Last
   Contract Number:      First - Last
   Project ID:           First - Last
   Project Number:       SECOND - SECOND
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
 Exclude:  Posted: No    Unposted: No
 Sorting:  by Customer ID
 Project Number      Project Name
--------------------------------------------------------------------------------------------------------------------------------------
 Fee ID          Fee Name                       Estimated Revenues  Estimated Profits
--------------------------------------------------------------------------------------------------------------------------------------
                       From Inception to 1/31/2006               |        At 1/31/2007                   For the year ended 12/31/2006
--------------------------------------------------------------------------------------------------------------------------------------
  Revenues   Recognized     Cost of Gross Profit   Billed to | Cost & Est.  Billings in |   Revenues   Recognized    Cost of Gross Profit
  Earned     Revenue        Revenues    (Loss)     Date  |   Earnings in Excess of |    Earned      Revenue   Revenues          (Loss)
                                                                                 |      Excess of   Costs & Est. |
                                                                                 |      Billings    Earnings |
--------------------------------------------------------------------------------------------------------------------------------------
 SECOND          Second
 LEGAL FEES      Legal Fees                                  $30.00             $30.00

  $5.02       $5.02       $0.00       $5.02      $30.00        $0.00       $0.00        $0.00       $0.00       $0.00       $0.00
  ----------  ----------  ----------  ----------  ----------   ----------  ----------   ----------  ----------  ----------  ----------
  $5.02       $5.02       $0.00       $5.02       $30.00       $0.00       $0.00        $0.00       $0.00       $0.00       $0.00
 SECOND          
Total Estimated Revenues:              $30.00
 SECOND          
Total Estimated Profit:                $30.00

  ==========  ==========  ==========  ==========  ==========   ==========  ==========   ==========  ==========  ==========  =========
  $5.02       $5.02       $0.00       $5.02       $30.00       $0.00       $0.00        $0.00       $0.00       $0.00       $0.00
                                                                                                                                   
Total Estimated Revenues:              $30.00
                                                                                                                                     
Total Estimated Profit:                $30.00
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Projects in Progress - Cost Category/Transaction List

The Project in Progress - Cost Category/Transaction report displays the 
cost transactions for the budget and the date range will include the 
selected fiscal year.

To print a Projects in Progress - Cost Category/
Transaction list:
1. Open the Performance Reports window.

(Reports >> Project >> Performance)

2. Choose Projs. in Progress-Cost Cat from the Reports list and choose 
New to open the Performance Report Options window.

3. Enter an option name and select the range and sorting method. Mark 
the Include Cost Transactions checkbox.

If the Include Cost Transactions checkbox is not marked, the original PA 
Projects in Progress - Cost Category report will be printed.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Performance Report Options window.

6. Choose Print.

Report Writer Name: 
PA Projects in Progress - Cost 

Category/Transaction

Tables:
PA Reports Project TEMP

PA Project Master File

PA Budget Master File

PA Budget Periodic Totals 
TEMP1

PA Budget Periodic Totals 
TEMP2

PA Budget Periodic Totals 
TEMP3

PA Cost Trx Line TEMP

Ranges:
Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Exclude:
Posted

Unposted

Sorting:
by Customer ID

by Contract Number

by Project ID

by Project Number

by Project Class ID

by Project Manager ID

by Business Manager ID

by Department
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PA Projects in Progress - Cost Category/Transaction List

System: 2/26/2006  1:01:49 PM                                                                                                                                                                   
User Date: 2/26/2006
Page:   1                                                                                                                                                                                       
User ID:   sa
                                                                                                     Fabrikam, Inc.
                                                                                                     Project Series
                                                                                           Projects in Progress - Cost Category
                                                                                                      As of 1/31/2007
 Ranges:
   Customer ID:          First - Last
   Contract Number:      First - Last
   Project ID:           First - Last
   Project Number:       ADSBILL - ADSBILL
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
 Exclude:  Posted: No    Unposted: No
 Sorting:  by Customer ID
 Project Number      Project Name
--------------------------------------------------------------------------------------------------------------------------------------
 Cost Category ID  Cost Category Name             Estimated Revenues  Estimated Profits
--------------------------------------------------------------------------------------------------------------------------------------
              From Inception to 1/31/2007                                At 1/31/2007                     For the year ended 12/31/2006
--------------------------------------------------------------------------------------------------------------------------------------
       Revenues      Recognized    Total Costs      Committed        Cost of   Gross Profit       Billed to   Estimate Cost     Cost & 
Est.    Billings in        Revenues     Recognized        Cost of   Gross Profit
         Earned         Revenue       Incurred          Costs       Revenues         (Loss)            Date     to Complete     Earnings 
in      Excess of          Earned        Revenue       Revenues         (Loss)
                                                                                                                                  Excess 
of   Costs & Est.
                                                                                                                                   Billings       
Earnings
--------------------------------------------------------------------------------------------------------------------------------------
 ADSBILL           Billboard Ads
 CABFARE           Taxi Cab Fares                          $26,811.00            $200.00
           $0.00           $0.00        $307.05          $0.00          $0.00          $0.00           $0.00      $26,303.95           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 COPIER            Copier Charges                         $580,150.00         $26,650.00
           $0.00           $0.00     $12,000.00          $0.00          $0.00          $0.00           $0.00     $541,500.00           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 DESIGN            Product Design                          $15,397.48            $189.98
           $0.00           $0.00         $44.20          $0.00          $0.00          $0.00           $0.00      $15,163.30           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 FEEREVENUE        Consulting Fixed Fee Revenues          $889,300.00          $1,000.00
           $0.00           $0.00     $19,687.50          $0.00          $0.00          $0.00           $0.00     $868,612.50           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 OFFICE SUPPLIES   Office Supplies                        $504,034.61         $55,086.11
           $0.00           $0.00      $2,436.57     $44,193.25          $0.00          $0.00           $0.00     $446,511.93           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
 XHARDWARE         Testing Non -IV Item                         $0.00       ($20,000.00)
           $0.00           $0.00        $224.20          $5.88          $0.00          $0.00           $0.00      $19,775.80           $0.00          
$0.00           $0.00          $0.00          $0.00          $0.00
--------- --------- -------- -------- -------- -------- --------- --------- --------- --------- --------- --------- ---------- --------
$0.00      $0.00     $34,699.52  $44,199.13    $0.00          $0.00           $0.00   $1,917,867.48           $0.00          $0.00           
$0.00          $0.00          $0.00          $0.00
                                                                                                                                                        
ADSBILL         Total Estimated Revenues:          $2,015,693.09
                                                                                                                                                         
ADSBILL         Total Estimated Profits:              $63,126.09
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Year To Date Employee Utilization List

Print the Year to Date Employee Utilization List to get an overview of 
billing activities for labor expended in a given year to date. The report 
also displays the hours expended, non-billable hours, maximum billable 
hours, billable hours, percentage of utilization, standard rate, maximum 
billing, actual billings and percentage of realization for the year to date 
and period selected.

To print a year to date employee utilization list:
1. Open the Performance Reports window.

(Reports >> Project >> Employee Utilization)

2. Choose YTD Employee Utilization from the Reports list and choose 
New to open the Employee Utilization Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Employee Utilization Report Options 
window.

6. Choose Print.

Report Writer name
PA YTD Utilization

Report table
PA Utilization Report TEMP

Ranges
Last Name

First Name

Employee ID

Sorting options
Employee ID

Include
Standard Hours Per Day

Report Ending Date
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Year To Date Employee Utilization List

System: 9/11/06    12:18:06 PM                                                                                                                                                                                
User Date: 9/11/06
Page:   1                                                                                                                                                                                                     
User ID:   sa             
                                                                                                         Fabrikam, Inc.        
                                                                                                         Project Series
                                                                                               YTD Utilization Report By Employee
Range:
    Employee ID: First - Last
                                                         Year To Date                                                                                           
Period Ending  9/30/06
--------------------------------------------------------------------------------------------------------------------------------------
Employee             Hours   Non-Billable Max Billable   Billable   %Utilization       Max     Actual %Realization  Hours In Non-Billable 
Max Billable     Billable   %Utilization       Std            Max        Actual %Realization
                                          Hours        Hours      Hours            Billings     Billings       Period       Hours         
Hours        Hours        Rate       Billings      Billings  
--------------------------------------------------------------------------------------------------------------------------------------
 Pilar Ackerman     1,392.00           0.00     1,392.00      0.00      0.00    $167,040.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00   $120.00     $20,160.00         $0.00    0.00
 
 Gregory Erickson  1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Jenny Doyle        1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Nancy Buchanan     1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Adam Barr          1,392.00           0.00     1,392.00       0.00      0.00     $167,040.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00   $120.00     $20,160.00         $0.00    0.00

 Jay Jamison        1,392.00           0.00     1,392.00       0.00      0.00           $0.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $0.00          $0.00         $0.00    0.00

 Kathie Flood       1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Brenda Diaz        1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Jane Clayton       1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 John Chen          1,392.00           0.00     1,392.00       0.00      0.00       $6,960.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $5.00        $840.00         $0.00    0.00

 Paul West          1,392.00           0.00     1,392.00       0.00      0.00           $0.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $0.00          $0.00         $0.00    0.00

 Jim Stewart        1,392.00           0.00     1,392.00       0.00      0.00           $0.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00     $0.00          $0.00         $0.00    0.00
 
 Luis Bonifaz       1,392.00           0.00     1,392.00       0.00      0.00     $167,040.00        $0.00    0.00       168.00         0.00       
168.00         0.00      0.00   $120.00     $20,160.00         $0.00    0.00

 Roger Harui       1,392.00           0.00     1,392.00       0.00      0.00           $0.00        $0.00    0.00       168.00         0.00       
168.00        0.00      0.00     $0.00          $0.00         $0.00    0.00
--------------------------------------------------------------------------------------------------------------------------------------
                 19,488.00           0.00    19,488.00     0.00      0.00     $549,840.00       $0.00    0.00     2,352.00       0.00     
2,352.00      0.00      0.00    $28.21     $66,360.00         $0.00    0.00
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Project Cost Breakdown List

The Project Cost Breakdown List displays all the cost transactions within 
a specified date range. You can also restrict the projects that are to be 
displayed on the report by using the following ranges: Customer ID, 
Contract Number, Project ID, Project Number, Project Class ID, Project 
Manager ID, Business Manager ID, Department and Contract Class ID.

To print a Project Cost Breakdown list:
1. Open the Project Status Reports window.

(Reports >> Project >> Project Status)

2. Choose Project Cost Breakdown from the Reports list and choose 
New to open the Project Status Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Project Status Report Options window. 
Choose Print.

Report Writer Name:
PA Project Cost Breakdown

Tables:
PA Cost Trx Line TEMP

PA Project Master File

PA Budget Master File

PA Cost Category Master File

Ranges:
Date

Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting:
by Customer ID

by Contract Number

by Project ID

by Project Number

by Project Class ID

by Project Manager ID

by Business Manager ID

by Department
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Project Cost Breakdown List

System: 2/26/2007  1:26:04 PM                                                                                                                                                                             
User Date:   2/26/2007
Page: 1                                                                                                                                                                                                   
User ID:     sa
                                                                                                             Fabrikam, Inc.
                                                                                                             Project Series
                                                                                                          Project Cost Breakdown
 Ranges:
   Date:                 1/1/2006 - 12/31/2006
   Customer ID:          First - Last
   Contract Number:      First - Last
   Project ID:           First - Last
   Project Number:       ADSTVCOMM - ADSTVCOMM
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
 Sorting: by Customer ID
 -------------------------------------------------------------------------------------------------------------------------------------
  Project No.        Project Name
 -------------------------------------------------------------------------------------------------------------------------------------
  Cost Category ID   Cost Category Name                   Forecast Unit Cost        Forecast Qty    Forecast Overhead  Forecast Total 
Cost  Forecast Profit %    Forecast Profit $  Forecast Total Profit    Forecast Revenues
                                                          Baseline Unit Cost        Baseline Qty    Baseline Overhead  Baseline Total 
Cost  Baseline Profit %    Baseline Profit $  Baseline Total Profit    Baseline Revenues
 -------------------------------------------------------------------------------------------------------------------------------------
  Date       Document No.        Cost Owner   Quantity   Total Cost   Total Overhead   Tax Amount    Accrued Revenues  Billed Qty      
Billing Amount  Billing Tax Amount            Retention     Trade Amt
 -------------------------------------------------------------------------------------------------------------------------------------
  ADSTVCOMM          TV Commercials
  CASH               Cash                                            $100.00                  400.00            $2,000.00           $42,000.00              
0.00%                $0.00           ($42,000.00)                $0.00
                                                                     $100.00                  400.00            $2,000.00           $42,000.00              
0.00%                $0.00           ($42,000.00)                $0.00
  1/7/2008   EL000000000003004     COMPUTERS     13.50     $1,063.13    $50.63           $0.00        $0.00         0.00
              $0.00               $0.00                $0.00         $0.00
--------------------------------------------------------------------------------------------------------------------------------------
                                                                         $1,063.13              $50.63               $0.00               $0.00                            
$0.00               $0.00                $0.00         $0.00
  CLOTHING           Clothing                                        $500.00              509.00                $0.00          $254,500.00             
10.00%                $0.00             $25,450.00          $279,950.00
                                                                     $500.00              509.00                $0.00          $254,500.00             
10.00%                $0.00             $25,450.00          $279,950.00
  1/20/2008  EE000000000006000    BANK0001         4.00     $2,000.00    $0.00           $0.00         $480.00      0.00              
               $0.00               $0.00                $0.00         $0.00
 -------------------------------------------------------------------------------------------------------------------------------------
                                                                         $2,000.00               $0.00               $0.00             $480.00                            
$0.00               $0.00                $0.00         $0.00
  CONSULTING         Consulting Fees                                  $35.00              802.00            $2,807.00           $30,877.00              
0.00%               $75.00             $29,273.00           $60,150.00
                                                                      $35.00              802.00            $2,807.00           $30,877.00              
0.00%               $75.00             $29,273.00           $60,150.00
  1/8/2008   TS000000000002001   BLAC0001            6.00             $118.80              $10.80               $0.00             $450.00         
0.00               $0.00               $0.00                $0.00         $0.00
  1/9/2008   TS000000000002000   BANK0001            8.25             $165.53              $15.05               $0.00             $618.75         
0.00               $0.00               $0.00                $0.00         $0.00
  1/10/2008  TM001               BLAC0001            0.00               $0.00               $0.00               $0.00               $0.00         
6.00             $450.00              $29.93                $0.00        $22.50
 -------------------------------------------------------------------------------------------------------------------------------------
                                                                           $284.33              $25.85               $0.00           $1,068.75                          
$450.00              $29.93                $0.00        $22.50
  DESIGN             Product Design                                   $35.00              185.00              $647.50            $7,122.50              
0.00%               $75.00              $6,752.50           $13,875.00
                                                                      $35.00              185.00              $647.50            $7,122.50              
0.00%               $75.00              $6,752.50           $13,875.00
  1/9/2008   TS000000000002001   BLAC0001                 6.00             $106.26               $9.66               $0.00               $0.00         
0.00               $0.00               $0.00                $0.00         $0.00
 -------------------------------------------------------------------------------------------------------------------------------------
                                                                           $106.26               $9.66               $0.00               $0.00                            
$0.00               $0.00                $0.00         $0.00



28 P R O J E C T A C C O U N T I N G S A M P L E R E P O R T S

Project Cost Breakdown – Periodic List

The Project Cost Breakdown – Periodic List displays all the cost 
transactions within a specified date range at a periodic level. This report 
will display the periods of forecast values of the included date range.

To print a Project Cost Breakdown – Periodic List:
1. Open the Project Status Reports window.

(Reports >> Project >> Project Status)

2. Choose Project Cost Breakdown Periodic from the Reports list and 
choose New to open the Project Status Reports Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Project Status Report Options window. 
Choose Print.

Report Writer Name:
PA Project Cost Breakdown 

Periodic

Tables:
PA Cost Trx Line TEMP

PA Project Master File

PA Budget Master File

PA Cost Category Master File

PA Budget Periodic Totals 
Master File

Ranges:
Date

Customer ID

Contract Number

Project ID

Project Number

Project Class ID

Project Manager ID

Business Manager ID

Department

Contract Class ID

Sorting:
by Customer ID

by Contract Number

by Project ID

by Project Number

by Project Class ID

by Project Manager ID

by Business Manager ID

by Department
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Project Cost Breakdown – Periodic List

 System: 2/26/2007  1:28:53 PM                                                                                                                                                                                 
 User Date:   2/26/2007
 Page: 1                                                                                                                                                                                                     
 User ID:     sa             
                                                                                                             Fabrikam, Inc.
                                                                                                             Project Series
                                                                                                     Project Cost Breakdown-Periodic
 Ranges:
   Date:                 1/1/2007 - 1/31/2007
   Customer ID:          First - Last
   Contract Number:      First - Last
   Project ID:           First - Last
   Project Number:       ADSTVCOMM - ADSTVCOMM
   Project Class ID:     First - Last
   Project Manager ID:   First - Last
   Business Manager ID:  First - Last
   Department:           First - Last
   Contract Class ID:    First - Last
 Sorting: by Customer ID
 -------------------------------------------------------------------------------------------------------------------------------------
  Project No.        Project Name
 -------------------------------------------------------------------------------------------------------------------------------------
  Cost Category ID   Cost Category Name
 -------------------------------------------------------------------------------------------------------------------------------------
  Year    Period ID         Forecast Unit Cost         Forecast Qty    Forecast Overhead  Forecast Total Cost  Forecast Total Profit    
Forecast Revenues
                            Baseline Unit Cost         Baseline Qty    Baseline Overhead  Baseline Total Cost  Baseline Total Profit    
Baseline Revenues
 -------------------------------------------------------------------------------------------------------------------------------------
  Date     Document No.          Cost Owner           Quantity           Total Cost      Total Overhead          Tax Amount    Accrued 
Revenues  Billed Qty      Billing Amount  Billing Tax Amount           Retention     Trade Amt
 -------------------------------------------------------------------------------------------------------------------------------------
  ADSTVCOMM          TV Commercials
  CASH               Cash
    2007  Period 1                        $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
                                          $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
  1/7/2007   EL000000000003004   COMPUTERS                13.50           $1,063.13              $50.63               $0.00               
$0.00        0.00               $0.00               $0.00               $0.00         $0.00
 --------------- --------------- --------------- --------------- --------------- --------------- --------------- ---------------
                                                                          $1,063.13              $50.63               $0.00               $0.00                           
$0.00               $0.00               $0.00         $0.00
 --------------- --------------- --------------- --------------- --------------- --------------- --------------- ---------------
                                              Budget Totals:              $1,063.13              $50.63               $0.00               $0.00                           
$0.00               $0.00               $0.00         $0.00
  CLOTHING           Clothing
    2007  Period 1                        $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
                                          $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
  1/20/2007  EE000000000006000   BANK0001                  4.00           $2,000.00               $0.00               $0.00             
$480.00        0.00               $0.00               $0.00               $0.00         $0.00
 --------------- --------------- --------------- --------------- --------------- --------------- --------------- ---------------
                                                                          $2,000.00               $0.00               $0.00             $480.00                           
$0.00               $0.00               $0.00         $0.00
 --------------- --------------- --------------- --------------- --------------- --------------- --------------- ---------------
                                              Budget Totals:              $2,000.00               $0.00               $0.00             $480.00                           
$0.00               $0.00               $0.00         $0.00
  CONSULTING         Consulting Fees
    2007  Period 1                        $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
                                          $0.00                0.00                $0.00                $0.00                  $0.00                
$0.00
  1/8/2007   TS000000000002001   BLAC0001                  6.00             $118.80              $10.80                $0.00             
$450.00        0.00               $0.00               $0.00               $0.00         $0.00
  1/9/2007   TS000000000002000   BANK0001                  8.25             $165.53              $15.05                $0.00             
$618.75        0.00               $0.00               $0.00               $0.00         $0.00
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Change Order 

The Change Order report displays the total amount for all change orders 
with an Approved status. This is a formal statement of the change order 
that you can print and send to the customer. The report includes the 
original contract amount and total change order amount, based on 
modifications to budget and fees as a result of the change. Variance 
information for each project or the net change from the previous values 
are included for: quantity, profit, billings, and total cost.

To print a Change Order report:
1. Open the Change Order Reports window:

(Reports >> Project >> Change Order)

2. Choose Change Order from the Reports list and choose New to open 
the Change Order Report Options window.

3. Enter an option name and select the range and sorting method.

4. Choose the Destination button to open the Report Destination 
window.

5. In the Report Destination window, select a printing destination and 
choose OK to return to the Change Order Report Options window.

6. Choose Print.

Report Writer name
PA Change Order

Report tables
PA Change Order Edit List 

TEMP

PA Change Order Header 
WORK

PA Change Order Detail 
WORK

PA Change Order Fee Detail 
WORK

PA Contract Master File

PA Contract Change Order 
Master

Ranges
Customer ID
Contract Number
Change Order Number

Sorting options
Customer ID

Contract Number
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Change Order

  System:    5/10/2007  3:31:51 PM                                                                                                                      
Page:     1
  User Date: 5/10/2007                                                                                                                                  
User ID:  sa
                                                                                  Fabrikam, Inc.        
                                                                                  Project Series
                                                                                   CHANGE ORDER
  Ranges:
     Customer ID:          First - Last
     Contract Number:      First - Last
     Change Order Number:  First - Last

  Sorting: by Customer ID

  Customer ID:          ADVANCED0001
  Contract Number:      ADS
  Contract Name:        Advertising
  Change Order Number:  ADS0000001
  Change Order Date:    5/10/2007
  Track Changes To:     Baseline                           Approved By:          DIAZ-BREND-001
                                                           Position:             Customer Service Supervisor
  Description:                                             Approval Date:          5/10/2007
  Customer CO Number:                                      Begin Date:           1/1/2007
  Change Order Type:    Internal                           End Date:             12/31/2007
  Change Order Status:  Approved                           Revised By:
  Requested By:                                            Position:
  Estimated By:                                            Reason for Revision:
                                                           Last Revised Date:    5/10/2007

  Original Contract Amount  Revised Budget Total Amount  Revised Fee Total Amount  Change Order Total Amount          Margin
 -------------------------------------------------------------------------------------------------------------------------------------
             $17,226,942.39                        $0.00                 $2,000.00                  $2,000.00   ($585,884.50)
  Change Order Total Cost  Change Order Total Billings  Total Variance Cost  Total Variance Billings  Total Variance Quantity
 -------------------------------------------------------------------------------------------------------------------------------------
              $587,884.50                   $615,059.50            $7,773.50                $8,098.50                    15.00

  Project Number  Cost Category ID  Begin Date  End Date    Var. %  Markup %    Var. Unit Cost     Unit Cost     Profit Type  Billing Type
 -------------------------------------------------------------------------------------------------------------------------------------
                    Var. Qty      Quantity      Var. Profit      Profit Amt.   Var. Total Cost    Total Cost    Var. Billings     Billings
 -------------------------------------------------------------------------------------------------------------------------------------
  ADSBILL         CABFARE            1/1/2007    11/15/2007 0.00%   0.00%        $0.00             $102.35        Total Profit  STD
                     10.00        270.00         $0.00           $200.00        $1,023.50         $27,634.50     $1,023.50         $27,834.00
  ADSBILL         COPIER             1/1/2007    11/15/2007 0.00%   5.00%       $0.00            $1,300.00       % of Baseline  STD
                     5.00        415.00         $0.00           $0.00          $6,750.00        $560,250.00     $7,075.00       $587,225.00
              -----------   -----------   -----------        -----------     -----------        -----------   -----------       -----------
                     15.00       685.00         $0.00           $200.00        $7,773.50        $587,884.50     $8,098.50       $615,059.50

  Project Number  Fee Type         Variance %           Fee %      Variance Amount           Fee Amount
 -------------------------------------------------------------------------------------------------------------------------------------
  ADSBILL         Retainer               0.00%           0.00%            $1,000.00            $3,000.00
  ADSBILL         Retentions             5.00%          15.00%          $100,784.65          $302,353.96
  ADSBILL         Project Fee            0.00%           0.00%            $2,000.00           $12,000.00
                                                                -------------------  -------------------
                                                                        $103,784.65          $317,353.96
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PA Detailed Trial Balance

The PA Detailed Trial Balance lists General Ledger account balances and 
all transactions that affect each account for the period that you specified. 
This report also shows if the debits and credits are equal for the specified 
period. Print this report to review account activity for a specific range of 
accounts for an open or historical year.

To print a PA Trial Balance Detail report:
1. Open the PA General Ledger Reports window.

(Reports >> Project >> PA Detail Trial Bal.)

2. Enter the appropriate year to include in the report.

3. Select items to include.

4. Enter the start and end range dates.

5. Select or enter the start and ending account numbers to be included 
in the report.

6. Choose the Document Level option to print the report.

7. Choose Print.

Report Writer name
PA Detailed Trial Balance

Report tables
PA General Ledger Trial 

Balance Temporary

Ranges
Document Date

Account Number

Include
Posting Accounts

Unit Accounts

Inactive Accounts

Zero Balance/No Trx

Subtotal By
Journal Entry
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PA Detailed Trial Balance

 System:     6/6/2007       12:14:27 PM                          Fabrikam, Inc.                                             Page:  1
 User date:  6/6/2007                                            General Ledger                                     User ID:  sa
     Ranges:      From:                           To:
          Date:   1/1/2007                        12/31/2007
       Account:   7000-0001-0014-0000-0000        7000-0001-0015-0000-0000
Account:  7000-0001-0014-0000-0000         Description:  COGS/Expense - Specific                         Beginning Balance:                 
$0.00
      Trx Date     Jrnl No.  Source Doc     Audit Code      Document Number      Owner ID                          Debit             Credit
    ----------------------------------------------------------------------------------------------------------------------------------
      1/7/2008            26 PATS           GLTRX00000024   TS000000000002000    BANK0001                          $65.12              $0.00
      1/1/2008            27 PATS           GLTRX00000024   TS000000000002001    BLAC0001                       $6,502.76              $0.00
      1/15/2008           28 PATS           GLTRX00000024   TS000000000002004    BURN0001                          $74.00              $0.00
      1/10/2008           53 PABL           GLTRX00000026   TM001                ADVANCED0001                   $2,318.80              $0.00

                                                                     Net Change        Ending Balance
                                                           ---------------------------------------------------------------------------------
      Account:  7000-0001-0014-0000-0000           Totals:             $8,960.68             $8,960.68          $8,960.68              $0.00
Account:  7000-0001-0015-0000-0000         Description:  COGS/Expense - Specific                         Beginning Balance:                 
$0.00
      Trx Date     Jrnl No.  Source Doc     Audit Code      Document Number      Owner ID                          Debit             Credit
    ----------------------------------------------------------------------------------------------------------------------------------
      1/15/2008           38 PARVG          GLTRX00000034   PI000000000007000                                     $210.00              $0.00
      1/1/2008            39 PARVG          GLTRX00000034   PI000000000007001                                     $228.08              $0.00
      1/1/2008            41 PARVG          GLTRX00000034   PI000000000007003                                     $222.50              $0.00
      1/31/2008           45 PARVG          GLTRX00000035   PI000000000007006                                   $2,232.86              $0.00
      1/12/2008           47 PARVG          GLTRX00000036   TEST4PI                                               $111.00              $0.00
      1/15/2008           49 PARVG          GLTRX00000037   SAVE_PO                                               $350.00              $0.00
      1/1/2008            50 PAIV           GLTRX00000030   IV000000000008000    BURN0001                          $74.06              $0.00
      1/2/2008            51 PAIV           GLTRX00000030   IV000000000008001                                       $4.60              $0.00
      1/10/2008           52 PAIV           GLTRX00000030   IV000000000008002                                      $48.85              $0.00

                                                                     Net Change        Ending Balance
                                                           ---------------------------------------------------------------------------------
      Account:  7000-0001-0015-0000-0000           Totals:             $3,481.95             $3,481.95          $3,481.95              $0.00
                             Accounts   Beginning Balance              Net Change        Ending Balance            Debit             Credit
                           
=================================================================================================================
            Grand Totals:           2                $0.00            $12,442.63            $12,442.63         $12,442.63              $0.00



34 P R O J E C T A C C O U N T I N G S A M P L E R E P O R T S

Project Accounting Report Writer Name Reference

The following table lists the name of each Project Accounting report as it appears within Microsoft Dynamics GP and 
within Report Writer. You can use this information to more quickly locate a particular report you want to modify. 
Reports are listed by category, including the path to the window where the report can be printed.

If you are using Multicurrency Management, note that there are separate versions of some Report Writer reports that 
include multicurrency information. The Report Writer names for the multicurrency versions include the letters “MC”. 
For example, “PA Timesheet Posting Journal Reprint” and “PA Timesheet Posting Journal MC Reprint“.

Report Type Microsoft Dynamics GP Name Report Writer Name

Maintenance Reports (Reports > Project > Maintenance)

Vendor List Vendor List PA Vendor List

Position Rate Table List Position Rate Table List PA Position Rate Table List

Employee Rate Table List Employee Rate Table List PA Employee Rate Table List

Equipment Rate Table List Equipment Rate Table List PA Equipment Rate Table List

Billing Cycle List Billing Cycle List PA Billing Cycle List

Unit of Measure List Unit of Measure List PA Unit of Measure List

Billing Activity Reports (Reports > Project > Billing Activity)

Invoice Register Invoice Register PA Invoice Register

Aged Accrued Revenues Aged Accrued Revenues for Time and Materials Projects PA Aged Accrued Revenues

Fee List - Project Fees List By Project PA Fees List - by Project

Retention - Project Retention - Project PA Retention - All

Retention - Customer Retention - Customer PA Retention by Customer

Pre-Billing Worksheet - T&M Pre-Billing Worksheet - T&M (In Process) PA Pre-Billing Worksheet - T&M

Pre-Billing Worksheet - T&M Pre-Billing Worksheet - T&M (Billable) PA BPW T&M

Pre-Billing Worksheet - T&M Pre-Billing Worksheet - Fee (Billable) PA PBW Fee

Pre-Billing Worksheet - CP/FP Pre-Billing Worksheet - CP/FP (In Process) PA Pre-Billing Worksheet - CP/FP

Pre-Billing Worksheet - CP/FP Pre-Billing Worksheet - CP/FP (Billable) PA PBW CP/FP

Pre-Billing Worksheet - CP/FP Pre-Billing Worksheet - Fee (Billable) PA PBW Fee

Aged Work-In-Process Aged Work-In-Process for Time and Materials Projects PA Aged Work-In-Progress

Posting Journals (Reports > Project > Posting Journals)

Timesheet Timesheets Posting Journal - Reprint PA Timesheet Posting Journal Reprint

Employee Expense Employee Expense Posting Journal - Reprint PA Employee Expense Posting Journal Reprint

Equipment Log Equipment Log Posting Journal - Reprint PA Equipment Log Posting Journal Reprint

Miscellaneous Log Miscellaneous Log Posting Journal - Reprint PA Miscellaneous Log Posting Journal Reprint

Inventory Transfer Inventory Transfer Posting Journal - Reprint PA Inventory Transfer Posting Journal Reprint

Billing Billing Entry Posting Journal History Reprint PA Billing Posting Journal HIST Reprint

Revenue Recognition Revenue Recognition Posting Journal Reprint PA Revenue Recognition Posting Journal Reprint

Project Closing Distribution Breakdown Register - Reprint Project Closing PA Project Closing Distibutions Detail Reprint

History Reports (Reports > Project > History)

Timesheet Timesheet History Report PA History Timesheet

Employee Expense Employee Expense History Report PA History Employee Expense 

Equipment Log Equipment Log History Report PA History Equipment Log

Miscellaneous Log Miscellaneous Log History Report PA History Miscellaneous Log

Inventory Transfer Inventory Transfer History Report PA History Inventory Transfer

Purchase Order Purchase Order History Report PA History Purchase Order

Receivings Receivings History Report PA History Receivings

Purchasing Invoice Purchasing Invoice History Report PA History Purchasing Invoice

Returns Returns History Report PA History Returns
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Budget Reports (Reports > Project > Budget)

Cash Budget Cash Budget PA Cash Budget

Performance Reports (Reports > Project > Performance)

Earnings from Contract Earnings from Contract PA Earnings from Contract

Contracts Completed Contracts Completed Year End PA Contracts Completed <No Date Range>

Contracts in Progress Contracts in Progress PA Contracts in Progress - Company

Contracts in Progress - Customer Contracts in Progress - Customer PA Contracts in Progress - Customer

Projs. Completed Projects Completed Year End PA Projects Completed <No Date Range>

Projs. Completed-Cost Cat Projects Completed - Cost Category PA Projects Completed - Cost Category

Projs. Completed-Fees Projects Completed - Fees PA Projects Completed - Fees

Projs. In Process Projects in Process PA Projects in Process

Projs. In Process-Customer Projects in Process - Customer PA Projects in Process - Customer

Projs. In Process-Cost Cat Projects in Process - Cost Category PA Projects in Process - Cost Category

Projs. In Process-Fees Projects in Process - Fees PA Projects in Process - Fees

Net Write-downs Net Write-downs PA Net Write-downs

Employee Utilization Reports (Reports > Project > Employee Utilization)

Monthly Employee Utilization Monthly Utilization Report by Employee PA Monthly Utilization

YTD Employee Utilization YTD Utilization Report by Employee PA YTD Utilization

Annual Employee Utilization Utilization Report by Employee For the Year PA Annual Utilization

Monthly Utilization-Department Monthly Utilization Report by Department/Employee PA Monthly Utilization By Department

YTD Utilization - Department YTD Utilization Report by Department PA YTD Utilization By Department

Annual Utilization - Department Utilization Report by Department For the Year PA Annual Utilization ByDepartment

Monthly Utilization - Position Monthly Utilization Report by Position/Employee PA Monthly Utilization ByPosition

YTD Utilization - Position YTD Utilization Report By Position PA YTD Utilization ByPosition

Annual Utilization - Position Utilization Report by Position For the Year PA Annual Utilization ByPosition

Statements (Reports > Project > Statement)

Statement <none> PA Statement

Project Status Reports (Reports > Project > Project Status)

Earned Value Analysis Earned Value Analysis PA Earned Value Analysis

Project Cost Breakdown Project Cost Breakdown PA Project Cost Breakdown

Project Cost Breakdown Periodic Project Cost Breakdown - Periodic PA Project Cost Breakdown Periodic

Periodic Budget Periodic Budget PA Periodic Budget

Change Order Reports (Reports > Project > Change Order)

Change Estimate Change Order Estimate PA Change Order Estimate

Change Order Change Order PA Change Order

Change Order History Change Order History PA Change Order History

Change Order Budget Change Order Budget PA Change Order Budget

Detailed Trial Balance (Reports > Project > Detailed Trial Balance)

Detailed Trial Balance PA Quick Detailed Trial Balance PA Quick Detailed Trial Balance

Report Type Microsoft Dynamics GP Name Report Writer Name
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The following table lists the name of each predefined Project Accounting billing invoice format as it appears within 
Microsoft Dynamics GP and within Report Writer. The list excludes the DEFAULT format and the five blank invoice 
formats.

You can select a format in the Billing Report Setup window (Microsoft Dynamics GP menu > Tools > Setup > Project 
> Billing > Billing Report button) and in the Billing Entry Print window (Microsoft Dynamics GP menu > Tools > 
Setup > Project > Billing > Billing Report button).

The numeric keys appear as selections in the Billing Report Key field of the Billing Report Setup window. To view the 
full format name that corresponds to the key, click the field’s lookup button.

The shortened names in the Billing Format column appear as selections in the Bill Format field of the Billing Entry 
Print window. To view the full format name that corresponds to the shortened name, click the field’s lookup button.

If you are using Multicurrency Management, note that there are separate versions of some Report Writer reports that 
include multicurrency information. The Report Writer names for the multicurrency versions include the letters “MC”. 
For example, “PA Invoice Format Contract Detail Page 1“ and “PA Invoice Format Contract Detail Page 1 MC“.

Key Billing Invoice Format Name Billing Format Report Writer Name

1 T&M Summary A TM_SUM_A PA Billing Summary A Report Format

2 T&M Summary B TM_SUM_B PA Billing Summary B Report Format

3 T&M Summary C TM_SUM_C PA Billing Summary C Report Format

4 T&M Detailed A TM_DETAILED_A PA Billing Detailed A Report Format

5 T&M Detailed B TM_DETAILED_B PA Billing Detailed B Report Format

6 T&M Detailed C TM_DETAILED_C PA Billing Detailed C Report Format

7 T&M Consulting Project TM_INVOICE_1 PA Billing Invoice Format-Invoice Format 1

8 T&M Consulting Project With Tax Detail TM_INVOICE_2 PA Billing Invoice Format-Invoice Format 2

9 T&M Consulting Contract TM_INVOICE_3 PA Billing Invoice Format-Invoice Format 3

10 T&M Consulting Contract With Tax Detail TM_INVOICE_4 PA Billing Invoice Format-Invoice Format 4

11 T&M Detailed Project TM_INVOICE_5 PA Billing Invoice Format-Invoice Format 5

12 T&M Detailed Project With Tax Detail TM_INVOICE_6 PA Billing Invoice Format-Invoice Format 6

13 T&M Detailed Contract TM_INVOICE_7 PA Billing Invoice Format-Invoice Format 7

14 T&M Detailed Contract with Tax Detail TM_INVOICE_8 PA Billing Invoice Format-Invoice Format 8

15 T&M Pre-Billing Worksheet TM_INVOICE_9 PA Billing Invoice Format-Invoice Format 9

16 T&M Basic TM_INVOICE_10 PA Billing Invoice Format-Invoice Format 10

17 T&M Invoice 1 TM_INVOICE_11 PA Billing Invoice Format-Invoice Format 11

18 T&M Invoice 2 TM_INVOICE_12 PA Billing Invoice Format-Invoice Format 12

19 T&M Invoice 3 TM_INVOICE_13 PA Billing Invoice Format-Invoice Format 13

20 T&M Invoice 4 TM_INVOICE_14 PA Billing Invoice Format-Invoice Format 14

21 CP/FP Document Level Invoice CPFP_INVOICE_1 PA Invoice Format CP/FP Document Level Invoice

22 CP/FP Contract Level Invoice CPFP_INVOICE_2 PA Invoice Format CP/FP Contract Level Invoice

23 CP/FP Project Level Invoice CPFP_INVOICE_3 PA Invoice Format CP/FP Project Level Invoice

24 CP/FP Contract/Project Level Invoice CPFP_INVOICE_4 PA Invoice Format CP/FP Contract/Project Level Invoice

25 CP/FP Pre-Billing Worksheet CPFP_INVOICE_5 PA Invoice Format CP/FP Pre Billing Worksheet

26 CP/FP Basic CPFP_INVOICE_6 PA Invoice Format CP/FP Basic

27 CP/FP Invoice 1 CPFP_INVOICE_7 PA Invoice Format CP/FP Invoice 1

28 CP/FP Invoice 2 CPFP_INVOICE_8 PA Invoice Format CP/FP Invoice 2

29 Fee Document Level Invoice FEE_INVOICE_1 PA Invoice Format Fee Document Level Invoice

30 Fee Contract Level Invoice FEE_INVOICE_2 PA Invoice Format Fee Contract Level Invoice

31 Fee Project Level Invoice FEE_INVOICE_3 PA Invoice Format Fee Project Level Invoice

32 Fee Contract/Project Level Invoice FEE_INVOICE_4 PA Invoice Format Fee Contract/Project Level Invoice

33 Detail Page - Document Level Invoice DTLPAGE_DOC PA Invoice Format Document Detail Page 1
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34 Detail Page - Contract Level Invoice DTLPAGE_CONTR PA Invoice Format Contract Detail Page 1

35 Detail Page - Project Level Invoice DTLPAGE_PROJ PA Invoice Format Project Detail Page 1

36 Detail Page - Contract/Project Invoice DTLPAGE_CONPRJ PA Invoice Format Contract/Project Detail Page 1

37 Summary Page - Document Level Invoice 1 SUM_PAGE_DOC_1 PA Invoice Format Document Summary Page 1

38 Summary Page - Document Level Invoice 2 SUM_PAGE_DOC_2 PA Invoice Format Document Summary Page 2

39 Summary Page - Document Level Invoice 3 SUM_PAGE_DOC_3 PA Invoice Format Document Summary Page 3

40 Summary Page - Document Level Invoice 4 SUM_PAGE_DOC_4 PA Invoice Format Document Summary Page 4

41 Summary Page - Document Level Invoice 5 SUM_PAGE_DOC_5 PA Invoice Format Document Summary Page 5

42 Summary Page - Contract Level Invoice 1 SUM_PAGE_CONT_1 PA Invoice Format Contract Summary Page 1

43 Summary Page - Contract Level Invoice 2 SUM_PAGE_CONT_2 PA Invoice Format Contract Summary Page 2

44 Summary Page - Contract Level Invoice 3 SUM_PAGE_CONT_3 PA Invoice Format Contract Summary Page 3

45 Summary Page - Contract Level Invoice 4 SUM_PAGE_CONT_4 PA Invoice Format Contract Summary Page 4

46 Summary Page - Contract Level Invoice 5 SUM_PAGE_CONT_5 PA Invoice Format Contract Summary Page 5

47 Summary Page - Project Level Invoice 1 SUM_PAGE_PROJ_1 PA Invoice Format Project Summary Page 1

48 Summary Page - Project Level Invoice 2 SUM_PAGE_PROJ_2 PA Invoice Format Project Summary Page 2

49 Summary Page - Project Level Invoice 3 SUM_PAGE_PROJ_3 PA Invoice Format Project Summary Page 3

50 Summary Page - Project Level Invoice 4 SUM_PAGE_PROJ_4 PA Invoice Format Project Summary Page 4

51 Summary Page - Project Level Invoice 5 SUM_PAGE_PROJ_5 PA Invoice Format Project Summary Page 5

52 IV Document Level Invoice IV_INVOICE_1 PA Invoice Format IV Document Level Invoice

53 IV Contract Level Invoice IV_INVOICE_2 PA Invoice Format IV Contract Level Invoice

54 IV Project Level Invoice IV_INVOICE_3 PA Invoice Format IV Project Level Invoice

55 IV Contract/Project Level Invoice IV_INVOICE_4 PA Invoice Format Contract/Project Level Invoice

Key Billing Invoice Format Name Billing Format Report Writer Name
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